Biotics Hands-On Training

Biotics 4.0

August 2005
Contents

4Section 1:  Logging In


4Section 2:  Exploring Mapper Functionality


4Long Menus and Short Menus


4Using Navigator


5Using Zoom By


6Using Legend Manager


6Using Filter Manager


7Using Data in Oracle Tables


9Section 3:  Exploring Tracker Functionality


9Viewing Subject Areas


10Finding records


12Creating a Working List


13Generating One Working List from Another


15Section 4:  Creating New Records in Tracker


15Recording Distribution  Data in Biotics


18Section 5:  Creating New Features in Mapper


18Entering Input/Edit mode


18Creating New Features


22Section 6:  Creating a Working List in Mapper


22Create a Working List of EOs you have edited


22Create a Working List of EOs in Putnam County


23Section 7:  Editing EO and Source Feature Records in Tracker


23Edit an EO Record


23Edit a Source Feature Record


24Section 8:  Using ‘View Shape’ to Move between Applications


24Section 9:  Editing Existing Features in Mapper


24Move an EO Representation with a Point Source Feature


25Replace a Source Feature with a New Shape of the Same Feature Type


26Replace a Source Feature with a Source Feature of Another Feature Type


27Add New Source Feature(s) to an Existing EO Rep


28Remove Source Feature(s) from an Existing EO Rep


28Generate an EO Rep from an Existing Source Feature


29Edit EO Reps and Polygon or Line Source Features


31Section 10:  Setting User Preferences


31User Preferences in Mapper


31User Options in Tracker


33Section 11:  Using Biotics Help


34Section 12:  Deleting Features


34Delete an EO Representation


34Delete a Source Feature


36Section 13:  Posting


37Section 14:  Using Sub-EOs in Mapper


37Create a Sub-EO


37Create a Parent-EO


39Section 15:  Changing the Associated Element of EOs


40Section 16:  Advanced Editing in Mapper


40Cut a Hole in a Source Polygon Feature Using an Existing Feature


41Replace a Polygon with a Single Polygon Created from Two Polygons in a Copy Theme


42Create a Source Line Feature Following the Outline of an Existing Polygon


42Create a Source Polygon Feature Adjacent to and In Between Two Existing Features


43Create a Duplicate Source Feature From an Existing Source Feature


43Edit a Boundary Shared Between Adjacent or Identical Source Polygon Features


44Create a Polygon Source Feature from a Buffered Line


46Section 17: Supplemental Exercises in Tracker


46Element Group


46Find a Higher Classification Unit


47Add a New Classification Unit


47Add a New Element to the Database


50ANNEX:  Biotics 4 Tracker screens for supplementary hands-on exercises




Section 1:  Logging In

Biotics is an integrated set of applications (Mapper and Tracker) which allow multiple users to simultaneously access and edit data stored in ArcView 3.x shapefiles and an Oracle Database.  Each user may have access to either Tracker only, or Mapper and Tracker.  Each Mapper user has both a profile on the workstation and a unique login and password to access the Mapper and Tracker applications.  Tracker-only users do not require a unique profile on the Workstation.  

To log in to Mapper:

· Double click on the Mapper icon on your desktop.

· Type your User Name and Password (as specified for your workstation) at the login screen and click OK.  Note:  User Names and passwords are case-sensitive.

· The application will open a stored ArcView project file and will refresh all the shapefiles to ensure that all changes made by other users are reflected in the copies of the shapefiles which you are viewing.

To login to Tracker:

· Double click on the Tracker icon on your desktop

· Type in your User Name and Password, as above.

· The application will open and display the Tracker Welcome Window.

· Minimize Tracker until you get to Section 3.

Section 2:  Exploring Mapper Functionality

Long Menus and Short Menus

Mapper has two viewing modes.  By default, Mapper is set up so that when you log in, you are viewing Short Menus.  If you are familiar with ArcView, you’ll notice that some of the menus, buttons and tools you are used to seeing, are missing.  

· Choose Long Menus from the File menu.  You’ll notice that the Graphical User Interface (GUI) changes to display more buttons, menus and tools.  In Long Menus, almost all the functionality of raw ArcView is maintained (except for those functions that could cause corruption of multi-user shapefiles).

· Long and Short Menus are a toggle from the file menu.  Choose Short Menus from the File menu to return to the default state.  Note:  The functionality of a given menu item, button or tool remains the same whether you access it from Long or Short menus.

Using Navigator
When the application opens, you will see 4-6 themes in the View’s Table of Contents:  EO Reps (polygons), EO.Source Points, EO.Source Polygons, EO.Source Lines and optionally, Site.Polygons and Managed Area.Polygons.  These are the basic themes necessary for creating Element Occurrence Representations (EO Reps), Sites and Managed Areas, and will be covered later in the tutorial.  However, you may want to refer to background GIS layers to provide a basis for screen digitizing or queries.  The Mapper Navigator is an interface through which users can access all the layers in your GIS library without knowledge of their actual locations on your data server, or their often cryptic file names:

· Add Themes:  click the Navigator button [image: image1.jpg]



· The Working Data section shows all the available themes in your data warehouse. Click the + button next to the Municipal and Administrative Boundaries library, and then the Municipal and County Boundaries DataSet, the County Boundary layer until you see the Polygons theme.  

· Click the Polygons theme and click the right arrow to add it to the Open Themes list on the right, which reflects the themes in your View’s table of contents.  You may also retrieve a theme by clicking and dragging it over to the Open Themes list.

· Now open the Water Resources library, the Streams and Waterbodies Dataset, the Watersheds Layer and add the Polygons theme to the Open themes list.

· Rearrange the order the themes will appear in the View’s Table of Contents.  From the Open Themes list, click on Watersheds.Polygons and drag it top the top of the list.

· Click OK.  Mapper will add the County and Watersheds themes to the View and they will appear in the order they were listed in the Open Themes list in Navigator.

· Remove Themes:  click the Navigator button again.

· From the Open Themes list, click on a theme and click on the left arrow to remove it from the View.  You may also remove a theme by dragging and dropping it anywhere in the Working Data section of Navigator dialog (it does not have to be returned from the library from which it was removed).

· Note:  adding, removing and re-ordering themes can all be done in one operation.

Using Zoom By

The Mapper Zoom By feature is customizable by your Biotics Administrator.  In addition to the standard zoom by fields, which include EOCODE, feature-id and coordinates, it can also be configured to zoom by any theme for which you have a supporting coverage, such as counties, towns or watersheds.  The Zoom By tool will zoom to the requested feature in any theme for which it is configured.

· Choose Zoom By from the view menu, or click on the zoom by button [image: image2.jpg]


.

· Choose Quad Name from the Select Theme list and click OK.

· Choose Display List of All Features for search method and click OK.  A dropdown list containing all the Quad Names existing in the Quad theme appears.

· Choose a quad name from the list and click OK.  The Quadrangle borders theme is added to the View and turned on.

· Click on the Zoom By button again, and this time choose GNIS from the Select Theme list.

· Choose a place name from either the lake or mountains lists, and type it into the box.  This time you are not given an option of which search method you want.  Your Biotics administrator will configure your Zoom By to give you both search options or to default to one or the other.

Using Legend Manager

When you log into Mapper, the Managed themes (EO Reps, all source feature themes, and optionally, Managed Areas and Sites) display in the view with a default legend configured into your system.  In fact all themes that are configured to Navigator can have a stored legend which loads as the default, as well as additional legends that can be loaded on a manual basis.

· If the EO Rep.Polygons theme is not currently in your view, add it from Navigator.

· Double-click on the EO Rep theme in the View Table of Contents to bring up the ArcView Legend Editor.

· Create a new legend for Element Group – or any other item.

· Once you have a legend you like, click Apply and close the dialog.

· With the EO Rep.Polygons theme still active, choose Legend Manager from the Theme menu.

· Click the Save As button and give the legend a name in the Input box.

· When asked whether to save the legend as the default legend, please choose NO.

· Close the Legend Manager dialog.

· Open the Legend Manager again from the Theme menu.

· Select another existing legend from the list and click the apply button.  

· Close the dialog.

Using Filter Manager

In areas where there are a lot of data, the Mapper view can become very congested and it can be difficult to see what you are doing when editing an existing EO Rep or creating a new feature.  The Mapper filter manager allows you to create a query that will reduce the number of features visible and then save so that it can be used multiple times and is available to all users of the system. 

· Make the EO Rep polygon theme the active theme and make sure it is turned on.

· Choose Filter Manager from the Theme menu.

· Click on the New… button.  You may recognize the ArcView Query Builder window.

· Create a new query that will select all EO Reps of your favorite element by SNAME: ( [SNAME] = "PYROLA PICTA" ).  You can create a similar query as follows:

· Check the Update Values checkbox.

· Double click on SNAME in the Fields column on the left, so that it appears in the text box below.

· Single click on the = button.

· Double click on your favorite element from the Values column on the right.

· Click the OK button

· Give the filter a descriptive name in the Input box.

· Now you can apply your new filter.  Scroll through the Existing Filters list until you find the name of the filter you just created and select it from the list.

· Click the apply button and then close the Filter Manager window.  Now your view will display only the EO Reps of your favorite element. 

· Turn off the Source Polygon theme (and Managed Areas and Sites if they are on) in the Table of Contents so that the only polygons displaying in the view are the EO Rep polygons.  This will enable you to view the effects of your filter.

· To clear the filter and return to the full set of EO Reps, open the Filter Manager again from the theme menu.

· Click the Reset button.  

· You can apply and create filters for any managed theme.  When you open Filter Manager, the list of filters will default to those created for the active theme.  If you want to change themes, you can choose another theme from the Theme Name dropdown list at the top of the Filter Manager dialog.  Try applying some of the existing filters for one of the source feature themes.

· Reset all filters before moving on to the next section.

Using Data in Oracle Tables

Most of the attributes you see when working with EOs, Source Features, MAs, and Sites in Biotics are stored in Oracle tables.  The data in Oracle are joined to the shapefile through an Oracle view so they can be used in Biotics.   You can choose which attributes you would like to attach to your shapefile and can change that set based on the tasks you are trying to complete.  There are standard sets of Oracle attributes that are associated with your shapefiles by default.  These sets are designed to be applicable to most tasks.  If, however, you are trying to complete a task and the current set of attributes is not appropriate (too few or too many attributes), you may use the Add/Remove Oracle Attributes option to customize access to attributes.  Through this option you are able to access ALL the data that are stored in your Oracle database.  You may choose to attach a predefined Oracle view or individual tables to your shapefile.  By default, those tables that are commonly used for attribute storage (as opposed to internal application information) are listed when you select the Tables radio button.  

· With the EO Rep polygon theme active, use the ArcView identify tool [image: image3.jpg]


 to identify an EO Rep polygon.  Note the attributes that are displayed, then close the identify window.

· Choose Add/Remove Oracle Attributes from the Biotics menu.

· Choose the Remove All Oracle Attributes radio button and click the Apply button.   Notice that the default legends are condensed to a single symbol for all the managed themes.  This is because the field by which the legend was sorted was being pulled from an Oracle table, and now that you have removed the Oracle attributes, this field is no longer joined to the shapefile.

· Now use the identify tool again to identify an EO Rep, and notice that the list of attributes has shrunk.  Now you are only viewing the attributes that are associated with the shapefile itself.

· Now choose EO.Rep (polygons) from the Theme dropdown list and choose the Add Oracle Attributes radio button.  The rest of the dialog will become enabled.

· The View radio button is already selected.  Choose the EO_VIEW_ALL_ATT view from the dropdown list, click the apply button and then try the identify tool again.  Your Biotics administrator can customize oracle views for your program.  If you have a particular set of attributes you may need to join to your shapefile on a regular basis (i.e. for environmental review or for providing a shapefile to be used for conservation partners), it can be made into a view which can be joined to the shapefile at any time.

· Now choose the remove all oracle attribute radio button again and click the Apply button.

· With the EO.Rep (polygons) theme still selected in the dropdown, choose the Add Oracle Attribute radio button again, and this time, choose the Tables radio button from the enabled dialog below.   

· From the table dropdown list, choose the EO table.  Since both tables contain a feature-id or shape_id item, the join column lists below will default to feature-id.  Feature-ids in the EO Rep shapefile will be matched with the record with the identical feature-id in the eo table.  The eo table contains all the information input into Biotics when the EO Rep was created as well as tabular information entered through the Tracker application.  Click the apply button and use the identify tool again to see the fields joined to the shapefile.  

· Now suppose you want to display EO Reps by their RA value.  If you identify an EO Rep, you’ll see that there is an attribute called Est_Rep_Accuracy_id, but the data in this field are not very useful.  You need to join to the domain table that contains the definitions of Est_Rep_Accuracy_ID in order to create a useful query.   With the element_occurrence table still joined, now choose the d_est_rep_accuracy table from the table dropdown list (you’ll have to check the ShowAll checkbox for this table to show up in the list).

· This time you need to choose the join columns from the lists below.  Choose d_est_rep_accuracy_id from the data column list and from the Theme column list then click the OK button to close the dialog.

· Now make the EO Rep theme the active theme and choose Theme > Legend Manager.  You’ll see that there are two saved legends in the legend manager for EO Reps for Est Rep Accuracy id and for Est Rep Accuracy Description.  Try applying each of them.

· You may also make your own legend for Estimated Representation Accuracy:

· Double click on the EO Rep theme in the table of contents to bring up the Legend Editor.

· Choose Unique Value from the legend Type dropdown and choose Domain_Value from the Values_Field dropdown.

· Click the apply button and close the legend editor to display EO Reps by their RA value.

· Finally, choose Add/Remove Oracle Attributes from the Biotics menu again.

· Choose the Reestablish Standard Oracle Attributes radio button and click OK. 

Section 3:  Exploring Tracker Functionality

Viewing Subject Areas

When you log in to Tracker, you see the main window of the application. Closing the main window closes the application. You may see an optional “Welcome window,” which provides quick access to the different Subject Areas (types of files) in Tracker.  Whether or not the Welcome Window is displayed depends of how you set your user options (covered in Section 10).

The subject area is shown in the left-hand corner of the title bar You are in the Element subject area, which is the default for the application.  From this starting point you can create and edit element tracking, ranking, and characterization records, among others. The Welcome Window also shows the other subject areas (also called “Views”) in Tracker.

· Select Cancel to close the Welcome Window.

· On the menu bar, select View (use your mouse, or Alt-V).
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· Select Reference. The main window changes to the Reference view. 

· Go to View again and reopen the Welcome Window by selecting on “Welcome…”

· Switch to the “Existing” tab and select Element (single-click on icon and select OK, or double-click on icon).  The view changes back to the Element subject area and the Find Element window opens automatically. The Find window does not open automatically when you change views using the View menu. 

Finding records

The Find Element window allows you to search for Element Global, National, and Subnational Tracking records by certain commonly used, pre-defined parameters, such as name, rank, and ELCODE.
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· Close the Find Element window (X button) and reopen it using the menu (Tools – Find) or binoculars icon: [image: image7.png]



· Search by Subnational name. Return results containing all three geographic levels of Element Tracking records.  First use the Scientific-Common-Both radio button and the Comparison and Name whose number corresponds to your workstation number (e.g., LabUser 02 use #2), then try one or two other searches. To clear your previous search criteria, either select the New Search icon [image: image8.bmp], or simply change the criteria.

1. Scientific Name contains myotis

2. Scientific Name wildcard albi

3. Common Name ends with berry

4. Both contains burn

5. Scientific Name begins with Quercus

6. Common Name begins with blue

7. Scientific Name wildcard oak

8. Scientific Name contains maculatum

9. Common Name ends with fly

10. Common Name contains fly

· Using search # 2, 4, 6, 8, or 10, limit your results by element type (plant or animal) by selecting either Botanical or Zoological Name Type on the Classification tab. You can also limit by Name Category on that tab. Note the different result sets.

· Clear your search criteria and go to the Rank tab. Do one of the following searches, according to your workstation number. Limit your results to subnational (EST) records.

1. Global rank contains 1

2. Subnational rank exact match s1s2 (note that capital letters are not necessary in search)

3. Subnational rank ends with B

4. Subnational rank contains B

5. Subnational BCD-style rank wildcard R

6. Subnational rounded rank is SX or SH

7. Global rank contains Q

8. Subnational exotic status contains E

9. Subnational BCD-style rank exact match SP

10. Global rounded rank is G1 or GH

· Save the search you just did by selecting File – Save Search, typing in a Search Name, and clicking Save. Clear results (New Search button or File – New Search). Retrieve the saved search (File – Open Search).  It is available to reuse.

· Clear results and go to Code/ID tab. Note that you can search by partial or full ELCODE. Try a partial ELCODE search if you want to (e.g., search for all PDAST, AAAB, ABNC, PMPOA, AR, NFFUN, or IICOL).

· Go to the Options menu item.
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From the Code/ID tab, you can also search by Element ID, the non-information rich primary key in Biotics. Whether you are searching by ELCODE or by ID, whatever you enter on this tab overrides criteria on the other tabs. In contrast, the other search criteria on other tabs is additive—you can combine name, rank, classification, and location data in your search.

All the Find windows in Tracker work similarly to the Find Element window. It is the most complex, however, having the most tabs. 

Creating a Working List

A Working List is a set of Biotics Tracker records that can be saved and retrieved.  Working Lists can be created in any Subject Area, but not for higher Classification records or USFS Ecoregions. They appear in a grid on the main window of the application. The grid columns are unique for each subject area and are designed to give the information most useful for distinguishing between records at a glance.

A Working List is created by performing one or more searches using a Find window or the Query Builder tool. It represents a static snapshot of the records that met the search criteria when the working list was created or last updated and saved.  It is not dynamically refreshed as new records meet those criteria.

To create a Working List of Element Tracking records:

· Open the Find Element window. Do one of the searches by name outlined on p. 11, or create one of your own.  If you do your own search, make sure your results list contains at least one National-level record (ENT).

· Highlight the results rows you wish to put into a working list. There are several ways to do this:

· Use the mouse while holding down the Shift key to select multiple contiguous rows.

· Use the mouse while holding down the Control key to select multiple non-contiguous rows.

· Use the Select All button.

· Click the Select All and then Add to List buttons (or use Alt-A, then Alt-L). The records appear in the main window behind the Find window. Close the Find window.

· To save the list, select the List menu item and choose Save List As.

(There is also a List tool button with the same options: [image: image10.png]


)

· In the dialog box that opens, enter a name for your list (mandatory) and description (optional).
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· Select whether to allow other users to view only (Shared – No Updates Allowed) or to view and edit your list (Shared – Updates Allowed). Default is “Not Shared” (that is, only you would have access to this list).

· Select the Folder (choices are configurable in each installation, but in this database they are Zoology, Botany, Ecology, All groups). The default is All Groups.

· Select OK.  The working list name now appears above the list in the main window.
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Generating One Working List from Another

· Select Generate Working List from the List menu.

· A dialog opens that contains all the different choices of lists you can create from an Element Tracking working list (not just ones that apply to the list you have open.)

· From the dropdown menu, select “References from Global, National, and Subnational Elements” and make sure the Create New List radio button is selected. Select Next.
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· When the Save List As box opens, name your new References list and set the share and folder properties to Shared-No Updates Allowed and All Groups. Click OK.

· Change your View to the References subject area.

· Open the Reference Working List you just saved.

While you have the Reference list pulled up, open a Reference record by double-clicking on a row in the working list, or by selection File – Open – Reference details.  Click on different tabs in the Reference record. The fields are the same as in the BCD Source Abstract, with a few additions.

· Close the Reference record with the X in the top right corner of the window, or File – Close, or Alt-F-C.

· Change your view back to the Element subject area.  Note that you may have multiple working lists open at the same time.

Section 4:  Creating New Records in Tracker

With the exception of EO and Source Feature records in an installation using Biotics Mapper as well as Tracker, all other types of data records may be created in Tracker. (MA and Site records may be created in either application.)

To create a new EST record:

· On the Element Working List, highlight a national-level (US) record.

· Select File – New – Element Subnational Tracking (EST). An EST window opens which is marked “New Record” at the bottom. Notice that the name and reference fields are already filled in.  If a field is grayed out, it means that it cannot be typed into directly for editing. Those with a [image: image14.bmp] button next to them can be edited through the current window; those without this button next to them are editable elsewhere in the application and are read-only in the current window (e.g., ELCODE can only be entered in the Element Global Tracking record—EGT).

· From the Subnation dropdown, select YOUR STATE, or any subnation other than New York.  Note that the subnations (states or provinces) displayed are those for the nation of the ENT.  If the ENT had been for Canada, the Canadian provinces would have been displayed in the dropdown menu.

· This is the only field you need to fill in (besides the Subnational Scientific Name, which was filled in for you) in order to save the EST record.

· Save the record by selecting the save icon, File – Save, or Ctrl-S. The “New Record” notation goes away.

· Move to the Heritage Status tab. The Subnational Rank field contains the placeholder SNR, which means ‘Not ranked.’  SRANK is a required field, but the user doesn’t have to fill it in manually before saving the record, because the default value of SNR is filled in by the application.

· Change the SRANK and enter an Rank Change Date by clicking on the calendar control button [image: image15.bmp]. If you hit Enter or click OK, today’s date will by entered.  You can also type in the date using the yyyymmdd format, without hyphens.

· In the Distribution grid on the same tab, fill in values for all columns. The dropdown arrow for each column appears when you click on the cell or move from cell-to-cell using the arrow keys.

· Save the record.

· Minimize Tracker again until Section 7.

Recording Distribution  Data in Biotics

Prepared by Leah Oliver, 10-2004

Navigate to the following powerpoint presentation: Q:\BioticsTrainingMaterials\Coreher\Dist.Data
This section will familiarize the user with the difference between the element rank and the distribution data, the field defintions  and their location in the database, and the conceptual process.

This tutorial will lead you through a power point presentation and examples Biotics.

1)
Read through slides 1-3.  On the 3rd slide, the Distribution Data fields are listed, 

Origin, Regularity, Distribution Confidence, Current Presence Absence and 

Population.  These fields are different from the conservation rank, exp. S1.  The 

conservation rank is a numeric rank giving an indication about whether an 

element is imperiled or secure and common. The distribution data fields provide 

supporting information about the distribution of the element in the subnation.  The 

values highlighted in red make up the combination most frequently used for an 

element in a subnation.  Hit F1 in Biotics to open the Help.  You can read more 

about the domain values for each of the fields.  Type in the Field name into the 

Help to retrieve the domain values and their definitions.  

2) 

Look over slide 4-5. These slides indicate where the distribution data are 

contained.   To view in your own biotics session. Open and EST and navigate to the Heritage Status tab.  Slides 4 and 5 show you what the distribution data look like for a native, regularly occurring species in a subnation.  These examples are of the Rough leaved Loosestrife and the Bachman’s Sparrow, both elements that occur in Boiling Springs.

3) 
Slide 6 states the purpose of the distribution data grid. The point here being that it’s not intended to record history or all literature reports of an element in a subnation. The distribution data grid is intended to reflect the current understanding of the element in the subnation.  That is, if there was once a false report of a species, and then a year later the species was discovered in another location in the subnation, one would change the Distribution Confidence field from ‘Reported but false’ to ‘Confident’, and the Current Presence Absence from ‘Absent’ to ‘Present’.

4) 
Slide 7-8 More examples of entering Distribution Data. To get more information on entering data for a typical migrant or exotic, look in the Biotics Help for the following topic ‘Enter Distribution Data for Species Elements’.

5)
Slide 9. This slide outlines the conceptual process for entering the data.  First, a 

note about one of the non-intuitive fields ‘Regularity’.  Regularity, is suppose to 

get at whether or not the species is consistently present in the subnation. It may 

migrate in and out of the subnation each year, but it is expected that each year the 

species will return. Nearly all plant elements are regularly occurring.  Only if 

you’re working with an animal element do you need worry about the population 

field.  You won’t see this field in the application for plants.

6)       Now that you have been introduced to the conceptual process of entering these 

data, take a few moments and try the following examples. Try entering the 

distribution data of a native, historic species and a native, extirpated species. You 

can check your answers see slides 10 and 11.

7) 
The next exercise is intended to help the user assess when one changes the fields in the distribution data grid. Try to fill in the distribution data grid for points a and b in the following scenario.  The Arizona botanists maintains data on a native, rare plant Astragalus magdalenea var. personii.   At  point A the current understanding of this speciesin AZ is that it is a rare native.   Two years later at a rare plant conference the botany discovers that the species has been misidentified in the state and is really a different taxon.  This is point B.  Update the distribution data based on this new information.  Check your work again Slides 12-14

8)
Now that you’re a little more familiar with the use of the distribution data grid.  

Look at slide 15, it discusses some guidelines that the user should be aware of 

when entering these data. The take home points here are that the srank should be 

consitent with the distribution data. For example, an S1 implies that the species is 

native and present, if one were to fill in the following data they would conflict 

with the srank: Origin, native; Regularity, Regularly Occurring; Distribution 

Confidence, ‘Confident’, Current Presence Absence, ‘Unknown’.  The Unknown

 would be inconsistent.

9) 
If you have time try entering the following situations into the distribution data 

grid for whichever elements you wish. A species where it is not known whether 

it’s native or exotic, a species that’s both native and exotic in the same subnation, 

a migratory animal that’s absent as a breeder and a historic non-breeder, and a 

transient migrant. For more help on entering distribution data for migrants see the 

Biotics Help. Note here about the use of ‘Unknown’, ‘Unkown’ is a value in each of the fields and is not intended to be a catch-all or default value one fills in when you don’t know what value to fill in. It should be use with specific intent and sparingly. If you’re entering ‘Unknown’ into too many of the fields, question whether you should be entering the element into the database.Check your work against slides 16-20.  

10)       Lastly review the key concepts presented. These are outlined on Slide 21.

Section 5:  Creating New Features in Mapper

Entering Input/Edit mode

Until now you have been using Mapper in regular viewing mode.  While Mapper will allow you to make some edits from regular viewing mode, such as changes to tabular data, geographic feature edits are done in Input/Edit mode.  All Mapper users can enter Input/Edit mode – unlike Tracker, there is no such thing as a read-only Mapper installation.  When you enter Input/Edit, you have the ability to make changes to the shapefiles that house your managed themes.  The shapefiles to which you are making changes are actually duplicate copies that are stored in your Mapper workspace.  Each time you open a feature for editing, that feature is locked so that no other users can edit it until you finish making changes.  When you post your changes, your clones are compared to the “master” shapefiles, which are stored on your Mapper server, and the masters are then updated with the changes you made.  In this way, multiple users can make edits to the same themes.

· Choose Input/Edit from the Biotics menu.

· Choose the Element Occurrence palette.

· Choose Source Point as the feature to digitize.  Mapper brings up the “Adding/Removing Themes….” Message:  the Input/Edit “scene” is being added to your view.   This scene is configured by your Biotics Administrator, and contains all the themes you need for editing.  This includes all your managed themes, and may additionally contain other useful themes, such as DRGs.

· Once you are in Input/Edit mode, the title of the View changes to Input/Edit – Element Occurrences – Source Point and the Draw Point tool [image: image16.jpg]


 is active.  You are now ready to create a new source point feature.  However, suppose you then realize you need to draw a source polygon feature instead.  Right click in the View and choose Source Polygon from the popup menu.  Now the View title changes to Input/Edit – Element Occurrences – Source Polygon and the draw polygon tool becomes the active tool.

· In the next section you will create some new features.

Creating New Features

The following sections will walk you through creating new EO Representations from source features, following examples using the revised data model.  Where you see a blank line instead of a specific named location, please refer to the appropriate location list to fill in the blank (since all the workstations in this session are connected to the same database, and this is a multi-user system, this is to avoid having several people creating the exact same features all in the same place).  If you would like to confirm your decisions for conceptual feature type, locational uncertainty type or RA value, see the answer sheet provided with this tutorial.  

Example 1:  your field form describes an ovenbird (Seiurus aurocapillus) nest located in Dutchess county, Poughquag quad, using a GPS; The corrected GPS coordinates are  (see the coordinate location list for viable coordinates in New York).

1. From the Biotics menu, choose Input/Edit. 

2. Choose the Element Occurrence palette

3. Set the editable theme to Source Point. 

4. Click the Coordinate Entry button [image: image17.jpg]


 and either enter the coordinates in New York’s standard projection (UTM Zone 18) or click the Change button to use coordinate points unprojected, or from another projection, then click the Next Button.  Mapper will zoom to the location and place a point graphic on the View.

5. In the Create New Feature (Source) window, click Finish.

6. In the Select Element window, enter search criteria to select Ovenbird and click OK. 

7. In the Create Source Feature window:

a. Enter a source feature label (optional)

b. Select the appropriate conceptual feature type from the drop down list.

c. Select the appropriate locational uncertainty type from the drop down list.

d. Populate data as necessary on the Mapping and Observation tabs

e. Check the box next to Create EO Representation from Source Feature and click OK.

8. In the Create New Feature (EO Rep) window, click Finish.

9. In the Create Element Occurrence window:

a. Choose an appropriate Estimated Representation Accuracy from the drop down list on the Rep Details tab.

b. Populate other data as available on the Rep Detail and Rep Extent tabs.

c. Click OK.

Example 2:  eastern pondmussel (Ligumia nasuta) specimen collected in _________Lake (choose a Lake from the Lake list).

1. Before you can choose the editable theme, you need to know what type of source feature you are going to draw.  First, determine the appropriate conceptual feature type (CFT):  what was the observation – how many mussels were observed?   How big was the observation – was it larger or smaller than the minimum mapping unit – if it’s larger than the minimum mapping unit, was it larger in all dimensions or just in one dimension?

2. Now determine the locational uncertainty type (LUT).   How certain are you about the locational information provided in the data?   Does the certainty of the location vary by a certain distance (i.e. you know the observer was able to place the observation within x meters of the actual location)?   Is there an area by which the observation can be bounded?  Is there a geographic feature on the map that can help you place the observation?  

3. Now that you’ve determined the CFT and LUT, you are ready to create the source feature in Mapper.  If you are not already in the correct editable theme, right-click on the view and choose the appropriate feature type from the popup menu.

4. Draw your source feature.  It may be appropriate in this case to use a copy theme – if there is already a digitized coverage containing the feature you want to use as your source feature, you do not need to digitize it again.  You can simply copy it from the existing theme.  Add the Dutchess County and Putnam County Waterbodies themes from Navigator.  

5. Set your copy theme by right-clicking on the view and choosing Set Copy Theme.

a. Choose the appropriate waterbody theme from the list of themes.

b. With the white arrow, click on the feature you want to copy. You may only copy ONE feature at a time, otherwise multiple features will be made into one source. If the feature is a polygon, click inside the polygon. 

c. At Copy and Paste Selected Features, click Finish.

6. In the Create New Feature (Source) window, click Finish.

7. In the Select Element window, enter search criteria to select Ligumia nasuta and click OK. 

8. In the Create Source Feature window:

a. Enter a source feature descriptor (optional but useful)

b. Select the conceptual feature type from the drop down list.

c. Select the locational uncertainty type from the drop down list.

d. Populate data as necessary on the Mapping and tabs

e. Check the box next to Create EO Representation from Source Feature and click OK.

9. In the Create New Feature (EO Rep) window, click Finish.

10. In the Create Element Occurrence window:

a. Notice that the header area of the window lists the EO Rep’s identifying information (EO Number, Element Subnational ID and BCD_ELCODE).

b. Click OK.

c. In the next section you will populate the Rep Detail Tab for this EO in the Tracker application.

Example 3.  Patch of creeping St. John’s-wort (Hypericum adpressum) observed east of _________Lake (choose a lake name from the lake list).

1. Determine the CFT and LUT by answering the questions in steps 1 and 2 in the above example.

2. Once you have determined the CFT and LUT, you can determine the type of source feature you need to draw.  Make the appropriate source feature type the editable theme.

3. Draw your source feature, or use a copy theme, as appropriate.

4. Populate the source feature and EO Rep windows with the appropriate information from your field data.   Note:  in the Create New Feature window (EO Rep), you may choose to check the box next to Defer Calculation of Spatial Attributes.  In an edit session where you will be making a lot of changes, deferring calculation of attributes will save you time.  While some attributes (such as lat, long, acreage, utm_northing,  utm_easting, utm_zone) are mandatory, and will be calculated all the time, other attributes (such as county, town, TRS, watershed) can deferred, and their calculation can be done in bulk at the end of your edit session).   Before clicking Finish in the Create New Feature (EO Rep) window, see step 5.  

5. This element was observed east of the lake.  Did your EO Rep end up with an added buffer that actually shows the element occurrence in the lake?  If the buffer does occur in the lake, you may want to edit your final EO Rep.  Click the Edit button in the Create New Feature window.  Note: if you want to update the EO Rep with new data, you’ll want to edit the source feature and regenerate the EO Rep rather than editing the EO Rep feature.

6. Use the split polygon tool [image: image18.jpg]


 to chop off the part that intersects with the lake.

a. To use the tool, start drawing a line outside of the polygon you want to split and continue along the lakeshore, ending the line by double-clicking outside of the polygon.

b. Once the polygon is split into two pieces, choose the piece you don’t want with the pointer tool [image: image19.bmp] and hit the delete key on the keyboard.

7. Now click Next and then Finish in the Create New Feature window to complete your EO Rep.

Example 4.  Water-thread pondweed (Potamogeton diversifolius) observed along the shoreline of the east side and west side (only – not on the north or south side) of  _________Lake (choose a lake name from the lakes list).

1. This EO Rep will have two distinct source features.  This time, when creating each source feature, DO NOT check the box to Create Element Occurrence from Source Feature in the Create Source Feature window.  

2. Once both source features are created, you will use the chain tool [image: image20.bmp] to make them into an EO Rep.  With the chain tool selected, click and drag a box that intersects both source features.

3. At Generate EO From Source Feature(s), confirm that both source features are selected by looking at the number of source features selected.   If one of the source features is not selected, you may click on it in the view window, and the number of source features selected should increase by one.

4. Click Next in the window, and you should then see the now familiar Create New Feature (EO Rep) window.

Section 6:  Creating a Working List in Mapper

Now you are ready to edit the tabular attributes for the EOs you created.  Tabular editing is done in the Tracker application.  It would be convenient to have a working list in Tracker of all the EOs you have recently created or edited in Mapper.  Mapper provides functionality which allows you to create a working list based on any spatial or tabular query that can be done using the ArcView Query Builder tool, or using custom Mapper functionality.  In this section, you will create two working lists.

Create a Working List of EOs you have edited

1. Make the EO Rep polygons theme active and open the ArcView Query Builder [image: image21.jpg]



2. Create the following query in the query builder window:  ([mod_date] = “”) and click the New Set button.    Note: This will select all the EOs you created in the previous section.  If you skipped the previous section, you can manually select several EO Rep polygons, or use any other logical query you wish.

3. Close the query builder window.

4. To see the list of records you have selected, choose Long menus from the File menu and open the table for the EO Rep polygons theme and promote the selected records to the top using the promote button [image: image22.jpg]



5. Close the attribute table.

6. Choose Save Working List from the Biotics menu and fill in the following in the Save Working List dialog:

a. Choose the EO Rep theme from the Theme dropdown

b. Name the working list in the Name box

c. Fill in Description, Shared and Folder

d. Click OK 

Create a Working List of EOs in Putnam County

1. If the Counties.Polygons theme is not already in your view, open Navigator [image: image23.jpg]


 and add it from the Municipal Boundaries library.

2. Make the County theme active.

3. Use the Query Builder [image: image24.jpg]


 to select Putnam County by creating the following query:  ([County_Code] = “NYPUTN”) and clicking the New Set button.

4. Close the Query Builder.

5. Make the EO Rep Polygon theme active.

6. Choose Select By Theme from the Theme menu and fill in the dialog to select the features in the active theme that are COMPLETELY WITHIN the selected features of the COUNTY.POLYGONS theme and click the OK button.

7. Zoom to the selected set [image: image25.jpg]


 to view the selected features.

8. Click on the N button to verify the number of selected features in the EO Rep theme.

9. Choose Save Working List from the Biotics menu and fill in the following in the Save Working List dialog:

a. Choose the EO Rep theme from the Theme dropdown

b. Name the working list in the Name box

c. Fill in Description, Shared and Folder

d. Click OK 

Section 7:  Editing EO and Source Feature Records in Tracker

Once the EO has been mapped, you can enter the non-spatial EO data in Tracker. You can also access a tabular Source Feature record where repeat visit/observations data can be entered.

Edit an EO Record

1. Maximize Tracker and go to the Element Occurrence subject area (view).

2. Open the Working List of “EOs that you have edited” that you created in the previous section.

3. Double-click on the top row in the list. The EO detail window opens.

4. Move from tab to tab by using Alt + the underlined letter on the tab. You will notice that the labels on some fields are grayed out and/or the fields or controls are disabled.  These fields are entered in or calculated by Mapper when you create the EO and cannot be edited in Tracker. All the fields on the Locators are disabled in Tracker.

5. On the Rep. Detail tab, enter an appropriate value for Estimated Representation Accuracy, based on the information given to you in the example when you created the EO. Enter comments to back up your estimate.

6. On the next tab, Rep. Extent, enter an enter an appropriate value for Confidence Extent, based on the information given to you in the example when you created the EO.

7. On the Documentation tab, select the [image: image26.bmp] button next to the Reference field.

8. In the Find References window, search for references in which the Full Citation begins with Jones. Highlight any THREE of the resulting references and select OK to add them to the EO reference grid. Click the Primary checkbox next to one of the references.  This is how to designate “BESTSOURCE” in Biotics Tracker.

9. Delete one of the other references from the grid by highlighting it and clicking the [image: image27.bmp] button. The reference is removed from the EO record. Save the record.

10. Using the arrows in the lower left-hand corner of the EO window, move to the next EO record.  Edit some fields if desired and move to another record.

Edit a Source Feature Record
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Section 8:  Using ‘View Shape’ to Move between Applications

From Tracker, you can jump to the EO Rep in Mapper directly from the EO tabular record. The same functionality is available for MAs, Sites, and Source Features. You must have Mapper open (it can be minimized) in order to use this function.

· On the EO toolbar, select the View Shape button ([image: image29.bmp]).

· Maximize Mapper.  The EO Rep is selected and is centered on the screen.

· To verify that it is the EO Rep for the EO record you were editing:

1. Click on the Query Managed Theme(s) button ([image: image30.bmp]) and then in the middle of the EO Rep.

2. Select EO.Reps (Polygons) theme and click OK.

3. Check that the correct Element is listed. More that one may be listed if there are overlapping EOs in the location.

Section 9:  Editing Existing Features in Mapper

If you have new data for an existing element, you may want to go back and edit the original source feature.  

Move an EO Representation with a Point Source Feature

You have new information for the _________________ EO (choose an EO Code from the list provided) that indicates that it is more accurately mapped 30 meters to the east of where it is now located.  All the other information about the EO is still correct.  

1. If you’re not already in Input/Edit, choose Input/Edit from the Biotics menu.

2. Choose the Element Occurrence palette.

3. Choose an editable theme (when you edit an existing feature, you can access it from any editable theme, regardless of the feature type).

4. Zoom to the location of your EO. Use the Zoom By button [image: image31.jpg]


  and choose EO Rep (Polygons) - EOCODE from the list.   Then type the EOCODE into the Input box.  You must type the entire code, including the *NY at the end.  This input box is not case-sensitive.

5. Use the move point tool [image: image32.bmp] to click on the source point feature and drag it to a new location 30m to the east of its old location.  Before moving the point, you may need to use the distance tool to determine where the new location is.  You may find the move point tool underneath the dropdown tools under the edit feature tool [image: image33.jpg]


.  This may take a while; wait until the move arrow [image: image34.jpg]ot g




 shows up on the view before doing anything else.  Mapper gets very unhappy if you try to stack commands.

6. If there is more than one point at the location, a window will display where you will be asked to choose the appropriate source feature.  Choose the correct one and click the Finish button. 
7. In the Move Point Feature window, click Finish.  

8. In the Edit Existing Feature (EO Rep) window:

a. You may choose to check the box next to Defer Calculation of Spatial Attributes.

b. Click Finish to complete the regeneration of the EO Rep polygon.

Replace a Source Feature with a New Shape of the Same Feature Type

New York provided least rectangle data from BCD to create polygons for some EOs where they did not have actual boundaries digitized.  Now that Biotics is installed, they plan to go back as time and funding permit, and replace those rectangles with more accurate polygon data.  This can be accomplished using the replace button.

1. Use the ArcView zoom tool to zoom in to a least rectangle polygon.

2. Select the source polygon or line feature you want to replace using the red Edit tool [image: image35.jpg]


.  

3. At Select Designer Features, select  EO.SOURCE POLYGONS from the list.   When you click on the polygon, Mapper will most likely find both the source polygon and the EO Rep polygon.  Because the EO Rep polygon is generated from the sourced feature, whenever you want to update an EO Rep with new data, you need to edit the source feature.   

a. If there is more than one source polygon feature selected, choose the feature to be replaced from the Select Feature(s) window.  If you are unsure, highlight the source feature and click on the Flash Shapes button to flash the shape on the view.


4. Mapper will lock the feature for editing and the Edit Existing Feature box will display. The total No. of Features Digitized will = 0.  Now create your new polygon:

5. Digitize the new source feature, by selecting the polygon tool [image: image36.jpg]


 from the tool bar and digitizing a new polygon.

6. Click the Replace Button [image: image37.jpg]


 and Mapper will replace the original source feature with your new one.   The EO Rep polygon will still have its original shape because it has not yet been regenerated.

7. The Total no. of Features Digitized now = 1 in the Edit Existing Features window (source feature). Click Finish and the application will go through the process of archiving the old shape and making the new shape into a source feature.  The EO Rep theme will be turned on if it's not already and when processing is finished the new shape's vertices will be highlighted. 

8. The Edit Existing Feature window (EO Rep) will display.  Click Finish to re-generate the EO Rep using the new source feature.  The "new" source feature will have the same feature_id, locational uncertainty type and conceptual feature type as the "old" source feature.
9. The new shape takes on all the information from the old shape, including the conceptual feature type and locational uncertainty type.  If you want to change either at this point, you may query the source with the red query tool [image: image38.jpg]


 and change the Conceptual Feature Type and Locational Uncertainty by choosing new values from the dropdown list.   Based on the type of source feature (in this case, polygon) only appropriate values will be available in the CFT and LUT dropdown lists.

Replace a Source Feature with a Source Feature of Another Feature Type

Many programs convert to Biotics by dumping Latitude and Longitude values from BCD to create points with estimated uncertainty type.  In this case, the estimated uncertainty distance is usually determined by precision value.  Once all your existing data are in Biotics, you will probably start to create polygons as you begin to collect data in the revised data model.  As you go back and update these existing EO Reps with new information, you may need to replace a source point feature with a source polygon feature.

1. In this example, you will choose a point source feature that was derived from an old M- or G-precision record whose historical data indicate only that it was found in _________(choose a town from the town list – or just use the Zoom By tool in step 3).   The data still indicate that the observation was a conceptual point (i.e. one plant or one snake den, etc.), yet now we have the ability to map the occurrence to the town.  Determine the locational uncertainty type, and from there, the source feature to be digitized.

2. Use the Zoom by tool [image: image39.jpg]


 to zoom to the town in which your historical EO was found and from there, find an existing source feature with a large estimated uncertainty buffer.

3. Create a new source polygon feature using the Town theme as a copy theme.

a. Use the Set Copy Theme option in the pop-up menu. To access this menu right-click on the view.
b. You then are prompted to select the theme which contains the feature you would like to copy.    Choose the town theme from this list.  Since polygon is your editable theme, only those themes which contain the polygon features and are in your view's table of contents will be available.
c. Use the copy-paste tool [image: image40.jpg]


 to select the feature you want to copy.   Do not copy more than one feature at a time.
d. The feature you just copied becomes a graphic (it is easier to see if you turn off the copy theme).

4. At Create Source Feature, do NOT check the box to Create EO Representation from Source Feature.

Note:  if you want the new source feature to have the same tabular data as that of the source feature which is being replaced, at this point in the process you would need to go into Tracker and do a record copy, prior to replacing the source feature in Mapper.  Spatial attributes and fields that are required when creating a Source Feature (Conceptual Feature Type, Locational Uncertainty Type) are not copied/overwritten when a record is copied. Any nonrequired data that has been entered in the target record, including rows in the Observations grid, will be overwritten.
a)
Find the newly created Source Feature in Tracker
b)
From the Tools menu, select Copy Data From.

c)
The appropriate Find window opens. Search for and select the original source feature record from which you want to copy the data, and click OK

d)
Verify that the data has been copied from the original record to the newly created source feature record, prior to continuing.

5. Query the existing EO.Rep with one of the query tools [image: image41.jpg]


.  

6. Click on the Sources tab and click the Replace button.

7. At Generate EO From Source Feature(s), the Number of Selected Features will reflect the number of source features currently linked to the EO Rep.  Hold down the shift key and from the view, click on the source feature you want to replace to unselect it.   

8. Click on the new source feature to select it.  You may alternatively, click on the Unselect All button and then, from the view, reselect all the sources you want linked to the EO Rep.

9. When you have only the new source feature selected, click Next in the Generate EO From Source Feature(s) window.

10. At Edit Existing Feature (EO Rep), click Finish.

11. At Delete, choose to Unlink and delete the source(s) and click OK.   This option will delete the source feature from the shapefile.  If you wanted to keep the source feature, the Unlink only, do not delete the source(s) option will unlink it from the EO Rep but retain the source feature in the source point shapefile as well as in the source_feature table in the database.

Add New Source Feature(s) to an Existing EO Rep

You discover a second distinct population of Tiger Beetles (Cicindela patruela consentanea) within the separation distance from an existing occurrence (and therefore part of the same EO).   The new population consists of 307 beetles found throughout a stretch of beach approximately 1000m long.  Assume that the beach in this location is less than 12.5m wide (12.5m is the MMU for a Biotics system using 1:24,000 scale base maps).

1. Use the Zoom By tool to zoom to a Tiger Beetle occurrence (ELCODE: IICOL02233; existing occurrences range from 001-010; suffix: NY).

2. Determine your conceptual feature type and locational uncertainty type using the data in the example.  From there, determine your source feature type and make the appropriate source feature theme editable.

3. Create your new source feature.

4. At Create Source Feature, do NOT check the box to Create EO Representation from Source Feature.

5. Use one of the Query tools [image: image42.bmp] to the EO Rep to which you will add the new Source Feature.

6. If the Select Designer Features window displays, choose EO Reps and click OK.

7. If the Query Element Occurrences window displays, highlight the EO Rep to which you will add the new Source Feature(s) and click Details.

8. In the Query Element Occurrence window for the EO Rep, choose the Sources tab.  Mapper lists the existing source feature(s) for the EO Rep here.  Click the Add button to start the dialog to add your new source feature.

9. Select your new source feature by clicking it on the view.  Note that the Number of selected features in the Generate EO Representation from Source Features window increases by one.  Click Next to continue.

10. In the Edit Existing Feature (EO Rep) window, click Finish.  The EO Rep will be regenerated to include your new source feature.

Remove Source Feature(s) from an Existing EO Rep

Suppose you receive new EO Specifications for an element which indicate that the separation distance is greater than you had previously assumed.  Occurrences which you had mapped as multi-source EO Reps now need to be split apart so that each source feature represents a different EO.  The following two examples will walk you through the process of splitting apart the existing EO Rep and then creating a new EO Rep from the removed source feature.  This first step will remove the source feature from the existing EO Rep.

1. Use one of the Query tools [image: image43.bmp] to query the EO Rep to which you will remove Source Feature(s) (if you completed the previous example, you may want to use this EO Rep, since it has two source features – otherwise please refer to the list of EO Reps with multiple source features, choose one and zoom to it).

2. If there are multiple features in the area, the Select Designer Features window will display; choose EO Reps and click OK.

3. If there is more than one EO Rep polygon in the area, the Query Element Occurrences window will display; highlight the EO Rep to which you want to remove Source Feature(s) and click Details.

4. In the Query Element Occurrence window for the EO Rep, choose the Sources tab and highlight the source feature you want to remove from the list of source features.   If you are unsure which is which, you may highlight a source feature and click on the View Shape button.  The view will zoom to the extent of the selected source feature.  

5. Once you have the correct source feature selected, click the Remove button. 
6. At Delete, choose to Unlink only, do not delete the source(s).  This will remove the source feature from the existing EO Rep, however, the source feature will remain in the database and in the source feature theme.
7. In the Edit Existing Feature (EO Rep) window, click Finish.  The EO Rep will be regenerated minus the removed source feature.
Generate an EO Rep from an Existing Source Feature

This is a continuation of the above example, which will walk you through creating a new source feature from the source feature that was just unlinked.  

1. Click on the unlinked source feature using the chain tool [image: image44.jpg]


 .

2. At the Generate EO Representation from Source Feature(s), click Next.

3. At Create New Feature (EO Rep), click Finish.

4. At the Create Element Occurrence window, the new occurrence number for the new EO Rep is displayed.   Choose an Estimated  RA value and fill in any other relevant information and click OK.

Edit EO Reps and Polygon or Line Source Features

If you want to practice some more edits on existing features, use the following procedures on several EOs with source features of different types.

1. Enter Input/Edit mode and select Element Occurrences and the EO Representation Palette. 

2. Use the Zoom by button to zoom to the EO Rep or Source Feature you want to Edit. 

3. Decide if you need to edit the source feature or the EO Rep itself. The following guidelines may help:

Edit Source: Correct digitizing error, update shape of EO to reflect new/revised field data

Edit EO Rep: Make EO meet restrictions in EO directions (i.e. right side of trail, east of lake) 

4. Use the red Edit tool [image: image45.jpg]


 to select the feature to edit.

5. At Select Designer Features, choose the appropriate selection theme and click OK.

6. If there is more than one feature in your selection theme, an Edit Feature(s) window will display.  Choose ONLY ONE feature to edit and click OK.  Mapper will lock the feature for editing.  If you are unsure, you may highlight a feature and click the Flash Shapes button to see the feature highlighted on the View.

7.  At Edit Existing Feature, edit the feature by selecting the appropriate editing tool (see Online help topic: Editing the newly created shape).
Deleting Multiple Vertices from a line or polygon: Use the Delete Multiple Vertices tool [image: image46.jpg]


 to create a polygon or rectangle around the vertices you wish to delete. You may do this multiple times to delete non-contiguous vertices.  If you wish to delete to a point which lies in-between vertices, you must first create a new vertex using the Vertex Edit tool [image: image47.jpg]


 and then use the Delete Multiple Vertices tool to delete the unwanted vertices.

Deleting or adding a Single Vertex: Use the Vertex Edit tool [image: image48.jpg]


 to delete a vertex by placing it over the vertex you wish to delete and hitting the delete key on the keyboard, or to add a vertex by clicking at the location of the new vertex.

Reverse Line Direction: The Reverse Line Direction tool [image: image49.png]


 lets you reverse the direction of a selected line

Reshaping a Polygon: Use the Reshape tool [image: image50.jpg]


 to draw a polyline to reshape the existing polygon.   You must overshoot when starting and ending your new polyline. 

Because the Redefine tool forces you to overshoot, you may end up with extra vertices, which you can delete using the Vertex Edit tool [image: image51.jpg]


. 

Creating a Hole in a Polygon:  Use the scissors tool [image: image52.jpg]


 to draw a polygon to create a hole.

8. When you are satisfied with your edits, click finish in the Edit Existing Features window. Mapper will archive the old shape.  

9. If you are editing a source feature that is linked to an EO Rep, Mapper will regenerate the EO Rep and another Edit Existing Features window will display for the EO Rep.  Click Finish.

Section 10:  Setting User Preferences

User Preferences in Mapper

When you log into Mapper as yourself, you are always accessing your Mapper project, which is an ArcView project file.  Not only can you save changes to your project file, but you may also make customizations to the functionality of the application, which will be applied only to your user.  

· Choose Preferences… from the File Menu.

· General Tab:

· Change the Default Startup Menus drop down to Long Menus.  If you save your project before exiting Mapper, the next time you log into the application, your project will default to Long Menus.

· Designer Tab:

· Change the Load Scene drop down to “Add to View”.  Since the themes in your Input/Edit scene is set by your Administrator to contain the themes absolutely necessary for data entry and editing, it may not necessarily contain the themes you need for a specific purpose.  By choosing Add to view, your Input/Edit scene will load in addition to any themes you already have in your Table of Contents, rather than removing any themes that are not designated to be in the scene. 

· Query Tab:

· There are four Query tools in the Query Tool dropdown.  By checking or unchecking the Visible column next to a tool’s description, you can control which of the Query Tools display in your project.

· Click the radio button next to the Query tool you want to display as the default tool.  

· Zoom By Tab:

· Type a number in the View Extents box to set the display distance for point themes accessed by the Zoom By tool.  Note:  This number is NOT the scale, rather it is the distance in View units from the top to the bottom of the view screen.

· Choose a highlight color from the dropdown to change the color of the circle displayed around point features accessed by the Zoom By tool.

· Check the Select Features box if you want the Zoom By tool if you want the feature to which you zoomed to be selected after zooming.

· Refresh After Zoom indicates if a tiled theme will be refreshed after a zoom by search.  Check the box and click OK.  Then try using the Zoom by Feature and note that the appropriate DRG tiles are added to the table of contents and drawn on the view, while the tiles from your previous location are removed.   

User Options in Tracker

Personal options are set from the main window of the application.  You do not have to set your options every time you log in. They will be retained until you reset them.
· On the main window menu bar, select Tools – Options. 

· The Options dialog opens.  Set your options are shown below on the Startup tab.
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· Go to the Working list tab and set your options as shown below. 
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Options on the Query Builder tab will be discussed when Query Builder is demonstated.

Section 11:  Using Biotics Help

Biotics Help was completely re-written and re-organized for the release of version 4.0.  While most people are familiar with standard Help formatting and how to use it, this section is included in this tutorial to encourage you to use the Help to solve basic problems during your every day use of Biotics.  It is comprehensive, covering field definitions, basic digitizing, data entry and advanced editing topics, as well as Biotics Administration and Data Management, such as reparenting EOs and merging EOs.  You are strongly encouraged to take some time to browse through some of the help topics to familiarize yourself with the areas covered.

· From the Mapper or Tracker Help Menu, choose Biotics Help.  The help will open and the table of contents will be displayed on the left.

· Browse the Adding Biotics Features section for help with new feature creation.

· For help with basic edits, browse through the Editing Biotics Features section.
· For help with more complicated edits, open the Working With Maps section and see Creating and Editing Shapes – Editing Shapes – Advanced Shape Editing.
· From the Tracker application, open up a detail window from a subject area in which you are interested, and place your cursor in a field and hit the F1 key on the keyboard.  This will bring up the context sensitive help for that field (or for the entire tab, if appropriate).  You can also access Help from the menu and tool bar: 
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Section 12:  Deleting Features

EO Rep, Site, MA or source feature deletions can be done by any Mapper user.  This is not an Administrator function.  Any user that has access to Mapper can delete features or attributes.   For programs using both Mapper and Tracker, the work flow only allows you to delete EOs from the Mapper application.  Once an EO, MA, Site or Source Feature is deleted through Mapper, the tabular attributes are moved into the deleted schema of the database, and can no longer be viewed through the Tracker interface.  

Delete an EO Representation

A single EO Rep can be deleted using the delete tool.  Multiple EO Reps can also be deleted in mass, however, mass deletes are not covered in this tutorial (we don’t want to delete all of our training data).

1. From the Biotics menu, choose Input/Edit if you are not there already. 

2. Choose the Element Occurrence palette.

3. Set the editable theme to EO Representation and zoom in to a reasonable scale.

4. Use the red delete tool [image: image56.bmp] to select a single EO Rep with a point source feature and an areal-estimated buffer.

5. If the Select Designer Features window displays, choose EO Representations.

6. In the Delete Element Occurrence window, highlight the EO Rep to be deleted and click OK.

7. Click Yes in the Delete Selected Items confirmation window.

8. At Delete, choose “Unlink and delete the Source(s)” to delete the source feature as well as the EO Rep.
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9. Deleted features will be archived.  If you turn on the archive EO Rep theme and the archive EO. Source point theme, the features you deleted will display on the view.

Delete a Source Feature

You can also delete an EO Rep by deleting its only source feature.  Alternatively, you may delete one source feature from a multi-source EO Rep and the EO Rep will be regenerated without that source feature.

1. Use the red delete tool [image: image58.bmp] to select a single Source Feature, or click and drag a box to select multiple Source Features.  Note:  if you want to delete linked source features from a source feature palette, all source features selected in a single operation must belong to a single EO Representation.

2. If the Select Designer Features window displays, choose the Source Feature theme from which you wish to delete features.

3. In the Delete Element Occurrence Source Features window, highlight the Source Feature(s) to be deleted and click OK.

4. Click Yes in the Delete Selected Items confirmation window.

5. Deleting source features will trigger one of the following scenarios:

a. Deleting all the sources for a linked EO Rep will trigger a delete of the EO Rep as well.  In this case, click Yes in the Confirm Cascading Delete window to complete the process and the EO Rep and source feature(s) will be archived.

b. Deleting one or more source features (but not all) from a multi-source EO Rep will trigger a regeneration of the EO Rep feature and the Edit Existing Feature window will display.

6. Click Finish in the Edit Existing Feature window to complete the process and the old EO Rep and deleted source features will be archived.

Section 13:  Posting

When you complete an edit session, you must post your changes before leaving Input/Edit mode.  Remember, when you enter input/edit mode, you are making edits to themes stored in your workspace, called clones.   When you post your changes, your clones are compared to the “master” shapefiles, which are stored on your Mapper server, and the masters are then updated with the changes you made.  In this way, multiple users can make edits to the same themes.  In addition, posting removes the feature locks from all the features you edited, so now that your changes have been added to the master, other users can make edits to these features.  

1. Click on the door button  [image: image59.jpg]


 to close your input/edit session and post your changes to the master shapefiles.   

2. You may be asked if you want to calculate deferred attributes now.  Choose Yes to calculate deferred attributes for your edit session.  Note: choosing No, will post your changes without calculating deferred attributes.  If you continually choose No, attributes will just accumulate and will eventually result in EOs being exported to BCD without their spatial attributes, and your Administrator will have to track you down.  Deferred attributes can be created in several ways:  if you choose to defer attribute calculation on any of your edits, you will have deferred attributes to calculate.  You may also have deferred attributes to calculate if you edited EO Reps that had potential or actual parent/sub relationships.  Lastly, EOs may be configured to calculate intersecting Sites or Managed Areas, so if you created, deleted or edited a Site or MA, this will also accumulate deferred attributes.  

3. You will then be given the option of calculating deferred attributes for just the current feature or for All Features.  The current feature is the editable theme, as displayed on the title bar of your view.  All Features contains potential deferred attributes for all the managed themes.  Choose All Features from the dropdown, and click OK.

4. Once deferred attributes are calculated, you will need to click the door button again to post your changes.

Section 14:  Using Sub-EOs in Mapper

For more information about using Sub-EOs, see the Sub-EOs section under Working with EO Representation Polygons in the Biotics Help.  

Create a Sub-EO

You may decide to track information in sub-EOs after collecting large amounts of data for multiple years.  An example may be a single EO Rep that covers a large area surveyed by different organizations or jurisdictions.  Since you haven’t been tracking sub-EOs for this element in the past, you now want to create a sub for an existing principal EO. 

1. By definition, a sub-EO must be either completely within or exactly coincident with the EO Rep of the occurrence that you want to be the parent.  In this case, since we are using the sub-EO to track large amounts of survey data, we will make the sub coincident with one polygon of an existing multi-source EO Rep.  

2. From Input/Edit, make source polygon the editable theme.

3. Set the copy theme to EO.Source Polygons and click on the source polygon you want to copy to create a new EO Rep that will become the sub-EO.

4. At Copy and Paste Features, confirm that the copy theme and the destination theme are both EO.Source Polygons and click Next.

5. In the Create New Feature (Source) window, click Finish.

6. Select the ELCODE for the new source feature to be the same as the surrounding EO Rep and click OK.

7. In the Create Source window, check the box to Create EO Representation from Source Feature. 

8. Click OK. 

9. Click Finish at Create New Feature.

10. Click Ok at the Create Element window.

11. At the Confirm Sub-EO window, click Yes to make the EO a sub.

12. The General tab of the Create Element Occurrence window will list the parent EO id.  Click OK to complete the EO Rep.

Create a Parent-EO

When you create a principal EO around an existing principal EO, the potential parent-sub relationship is not evaluated until deferred attributes are calculated.  The reason for this, is the information that creates the parent-sub relationship, is only stored with the sub-EO.  Therefore, if you create a principal around an existing EO, the system will make note that there is a potential parent-sub relationship and will queue the existing EO up for deferred attribute calculation. Mapper cannot calculate the parent_eo_id attribute for the existing EO since you are not currently editing it.  Deferred attribute calculation for parent-sub relationships is affected by the “Update Parent-EO-on-Recalc” System Setting, which is controlled by your Biotics Administrator.  If your program uses sub-EOs, your System Setting for standard Mapper data entry should be “PROMPT” (if you are using this tutorial during Hands-On Biotics training, your system setting is set to PROMPT).    

1. Create a source  feature that completely surrounds an existing EO Rep polygon for which you want to create a sub EO.

2. In the Create New Feature (Source) window, click Finish.

3. Select the ELCODE for the new source feature to be the same as the contained EO Rep and click OK.

4. In the Create Source Feature window, check the box next to Create EO Representation from Source Feature.

5. Click OK.

6. In the Create New Feature (EO Rep) window, click Finish.

7. Click OK in the Create Element Occurrence window.

8. Set the editable theme to EO Reps.

9. Choose Calculate Deferred Attributes from the Input/Edit menu.  This step should be done after creating each parent EO – do not wait until the end of your edit session.

10. In the Calculate Deferred Spatial Attributes window, choose Current Feature Only from the drop down list and click OK.

11. Click Yes in the Confirm Sub-EO window.

Section 15:  Changing the Associated Element of EOs

A taxonomic revision may result in one previously recognized Element becoming two or more new ones (a split), or in the combination of two or more Elements into a new one (a lump). In either case, the EOs for the affected Element(s) will need to be reassigned to a new one(s). In Biotics 4, this is easily done in Tracker.

1. Maximize Tracker and go to the Element Occurrence subject area (view).

2. Open the Working List called “Change Element N,” where N is the number of your workstation.
3. Select all the EOs in the working list.
4. On the Tools menu, select “Change Associated Element.”  An Element Find window will open.
5. Enter the Genus name as the search criteria and click Find.
6. From your results list select any element of that genus (other than the one you started with in your working list).
7. Click OK
8. The operation may take a few moments if the number of EOs involved is large. When it is complete, a  summary window appears.  The original EO number will change only if the new Element already has EOs with the same numbers.  The results can be printed out to give you a log of the change in EO numbers. If it does, the updated EO numbers will start with the next available number.
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Section 16:  Advanced Editing in Mapper 

If you are already a Mapper user and you are comfortable with creating new features and making basic edits, you may want to start with this section which covers some more obscure edits that may come up in the process of editing real data. 

Cut a Hole in a Source Polygon Feature Using an Existing Feature

You have a small community EO Rep mapped in Mapper.  You want to add a new community EO that surrounds the existing EO Rep, but does not include the area already covered by the existing EO.  

1. Choose Input/Edit from the Biotics menu.

2. Choose Element Occurrences.

3. At Select Designer Features, choose the Source Polygons theme.

4. Zoom in to the existing community EO and right click to choose Set Copy Theme from the popup menu.

5. Choose the EO Source Polygon theme as the Copy theme and click OK.

6. Click on the source polygon feature that will form the “hole” using the copy-paste tool [image: image61.jpg]


, which should be active.

7. Click Edit in the Copy and Paste Features window to make the menus accessible.

8. At Copy and Paste Features, edit the resulting graphic by deleting anything additional to the polygon that will form the “hole”.

9. Choose Copy Graphics from the Edit menu to get the small polygon into the copy buffer.

10. Click Cancel from the Copy and Paste Features dialog.

11. Choose the polygon tool and draw your new source polygon feature.

12. At Create New Feature (source polygon), click Edit.

13. Choose Paste from the Edit menu. 

14. Using the pointer tool [image: image62.jpg]


, hold down the shift key and select the new source polygon feature so that both the new source polygon feature and the pasted graphic are selected.

15. Choose Subtract Graphics from the Edit menu to create the hole in your new source polygon feature.

16. If the small graphic still exists, select it with the pointer tool and hit the delete key on the keyboard to delete it from the view.

17. Click Next and then Finish in the Create New Feature (source poly) window.

18. At Create New Feature (EO Rep), click Finish.   If you’re not convinced that your new EO Rep has a hole in it, create and apply a filter for just the element which describes your new EO Rep.

Replace a Polygon with a Single Polygon Created from Two Polygons in a Copy Theme

You have a theme that was digitized outside of Mapper for a different purpose than creating EOs.  Even though it doesn’t represent the source feature you want to create exactly, you want to use the linework as a starting point for creating a new source feature.  In this case, the existing theme provides you with two polygons that you want to edit into one polygon and make into a source feature.

1. From Input/Edit mode, choose the polygon palette.

2. Create and activate a filter in both the EO.Rep polygons theme and the EO.Source polygons theme so that no polygons in the view are overlapping the source feature and EO Rep you want to edit.

3. Select the source polygon feature you want to replace using the red edit tool [image: image63.jpg]


.

4. Click right in the view and select Set Copy Theme from the popup menu.

5. Choose the appropriate theme as the copy theme.

6. Make the copy theme active and select the two polygons that will form your new source polygon feature using the ArcView select tool [image: image64.jpg]


.  

7. Choose Copy and Paste Features from the Edit menu.

8. At Choose Features, click Select All.

9. When prompted, choose Yes to dissolve interior lines.

10. Click the Replace button [image: image65.jpg]


 to replace the least rectangle source feature with the new shape(s).

11. Edit the resulting source polygon by using the polygon tool to digitize a polygon that fills in the space between the disjunct pieces and overlaps the edges of each existing piece (do not leave the new source feature as two disjunct shapes – if you want to use two disjunct shapes, each shape must be its own source feature).

12. Select all the pieces of the edited source polygon feature using the shift key and the pointer tool [image: image66.jpg]


 .

13. Choose Union Graphics from the Edit menu.

14. When you  are satisfied with your edits, click Finish at Edit Existing Feature (source).

15. At Edit Existing Feature (EO Rep), click Finish.

16. At Create Element Occurrence, choose an Estimated RA value from the dropdown list and click OK

Create a Source Line Feature Following the Outline of an Existing Polygon

You have an existing EO Rep that is mapped to a lake.   Your new EO is a source line feature that represents a portion of the shoreline of that lake.   You want the line representing the source line feature to match the line that was digitized for the existing source polygon feature.

1. Choose the line palette from Input/Edit mode.

2. Set the interactive snap tolerance by clicking and dragging a circle using the interactive snap tolerance tool [image: image67.jpg]


.

3. Choose Set Snap Options from the Input/Edit menu.

4. In the Snapping Options dialog:

a. Choose the theme you wish to snap to from the Themes in View and click the right arrow to move it into the Selected Themes list.

b. Set the snap mode to Vertex.

c. Leave the snap Method at Closest.

d. Click OK

5. Choose the Create Line from Dots tool [image: image68.jpg]


 to digitize your line source feature along the boundary of the polygon.  As you digitize, vertices should snap to vertices WITHIN THE SNAP TOLERANCE in the polygon feature.  If  your vertices are not snapping, you may need to zoom in closer or increase your snap tolerance (See Step 2).

6. When you finish digitizing your line, click right and choose Complete Shape from the popup menu to connect the dots.

7. At Create New Feature, click Finish.

8. All subsequent features you create will be in the current snapping environment.  Choose Set Snap Options from the Input/Edit Menu and set the Snap Options radio button to No Snapping to turn snapping off.

Create a Source Polygon Feature Adjacent to and In Between Two Existing Features

You have two communities mapped near each other.  Your ecologist does some more surveying and determines that the area in between the two existing EOs is a high quality community that should be mapped.  The new community is adjacent to the existing community on each side.  

1. Choose the source polygon palette from Input/Edit mode.

2. Use the append polygon tool to draw your source polygon feature adjacent to ONE of the existing source polygon features and overlapping the other source polygon feature.

3. At Create Feature, click the Edit button.

4. Use the Split With Features tool [image: image69.jpg]


  to select the overlapping source polygon feature.

5. From the dialog, choose the EO.Source polygon theme as the theme with which to split features.

6. Choose Yes when prompted to proceed with keeping the split feature.

7. Your new source polygon feature will be split into pieces.  Use the pointer tool [image: image70.jpg]


 to select the piece of the new source polygon feature overlapping the second feature, and hit the delete key on the keyboard to remove it.

8. Click Next and then Finish in the Create New Feature (source) window.

Create a Duplicate Source Feature From an Existing Source Feature

You go out to survey an existing EO and you discover an additional EO in the same place.  When you return to the office, you want to map the new EO with a source feature identical to the existing EO at that surveysite.

1. From Input/Edit mode, choose the  palette matching the feature you want to copy (Source Line, Source Point or Source Polygon).

2. Click right in the view to bring up the popup menu and choose Set Copy Theme.

3. Set the Copy theme as appropriate to EO.Source Point, EO.Source Line or EO.Source Polygon and click OK.

4. Click on the source feature you want to copy using the copy-paste tool [image: image71.jpg]


.  Note:  you may only copy one source feature at a time.   If you select more than one feature with the copy-paste tool, you will end up with a multi-part source feature, which is incorrect according to the methodology.
5. Confirm the Copy From and the Copy To locations in the Copy and Paste Features window and click OK.

6. At Create New Feature (source), click Finish.

Edit a Boundary Shared Between Adjacent or Identical Source Polygon Features

You have two EOs mapped to the same location (as in the example above).  You go out to do another survey and you discover that the area occupied by both EOs has expanded to the east.  Since both EOs share the same boundary, you don’t want to have to make the same edits twice.  You can edit both source features in the same operation.  Note: if you choose to edit the EOs you were working on in the previous example, you need to post first and return to Input/Edit to execute the following exercise.

1. Choose the Source Polygon palette from Input/Edit mode.

2. Select the Source Polygon feature for one of the source polygons, using the red Edit tool [image: image72.jpg]


.

3. At Select Designer Features, choose EO.Source Polygons.

4. If the Edit Feature(s) window displays, highlight the ONE feature to edit and click OK.

5. When the Edit Existing Feature window displays, using the vertex edit tool [image: image73.jpg]


 (which should already be the active tool), hold down the shift key and click on the adjacent  feature (or if the two features are identical, click on the feature again) to additionally lock the adjacent or identical feature for editing.  Both features should now have their vertices displayed.

6. Click outside of both features to unselect them both (be sure not to click on any other feature either – if this is not possible, you may have to cancel the process and create a filter and start over).

7. Click on the shared boundary.

8. Make your edits along the shared boundary using the available edit tools.

9. When you have completed your edits, click finish in the Edit Existing Feature (source) window.

10. Note that only the EO Rep polygon for the ORIGINAL feature you selected for editing will be regenerated from the new source feature.  A Biotics text window will display listing the feature id of the EO Rep that will not be regenerated.  You may click print to print this information and then Close to dismiss the window.

11. At Edit Existing Feature (EO Rep), click Finish to regenerate the original EO Rep. 

12. Regenerate the adjacent or identical EO Rep polygon:

a.  Select the adjacent or identical EO Rep with one of the Query tools [image: image74.jpg]


.

b. At Select Designer Features, choose EO.Reps (Polygons).

c. At Query Element Occurrences, select EO Rep to be regenerated and click on Details.

d. At Query Element Occurrence, click on the Sources tab and click the Add button.

e. At Generate EO From Source Feature(s), click Next.

f. At Edit Existing Feature (EO Rep), click Finish.

Create a Polygon Source Feature from a Buffered Line

You are mapping an EO from historical data.  The information you have indicates that Mountain Goldenrod (Solidago simplex var randii) was found (one plant) at 1000 ft on Mount _________ .  For the purposes of this example, assume that the 1000 ft. contour line is on the map, however, you are familiar with the collector of this plant, and you know that his elevation estimates are usually only accurate to within about 50 meters.  

1. From the information above, the conceptual feature type is a point.   The locational uncertainty type is Areal-Delimited, because the area in which the plant was found can be defined by 50m on either side of the 1000 ft. contour line.   Therefore, the source feature you want to create is a polygon defined by creating a 50m buffer along the 1000ft. contour.

2. Choose Long Menus from the File Menu in REGULAR VIEWING MODE.

3. Use the Line tool to draw a line which will create the buffered feature as a graphic in the view.

4. Choose Create Buffers from the Theme menu to bring up the ArcView Buffer Wizard.

5. Choose to buffer “The graphics in your view”

6. Check the “Use only the selected graphics” box and click Next.

7. Choose the “At a specified distance” option, type in a distance, choose the appropriate units and click Next.

8. Choose to save the buffers “As graphics in the view” and click Finish.

9. Use the pointer tool [image: image75.jpg]


 to select the buffer (the graphic currently selected is the original line).

10. Choose Copy Graphics from the Edit menu to copy the buffer.

11. Delete both the original line and buffer (both graphics) from the view by selecting them and hitting the delete key on the keyboard.

12. Choose Input/Edit from the Biotics menu and choose Element Occurrences and the Polygon Palette.

13. Choose Paste from the Edit menu to paste the graphic into the view.

14. Choose Copy and Paste Graphics from the Edit menu to make the graphic into a feature in the EO Source Polygon theme.

15. Confirm the From theme and the To theme and click Finish at the Copy and Paste Selected Graphics window to create a source polygon.

16. Click Finish at Create New Feature.

Section 17: Supplemental Exercises in Tracker

Log in to Tracker (see Section 1).

Element Group 

1. Select View on the menu of the main window. 
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2. Click on the Element Group line. The title bar now says Element Group in parentheses and the columns in the working list portion of the window have changed. Notice that the Element Group view did not open in a new window; it replaced the Element view. All the subject areas above the first line in the View list work that way. 

3. Click on the New icon ([image: image77.bmp]) or select File – New to open an empty Element Group record  (Screen I-1 in Annex). A new, unsaved record always says “New Record” in red at the bottom of the window.

4. Examine the dropdown options and fields in this window. Note that it is possible to list the elements that make up the group. However, the list is not required. Close the window with the X in the top left corner. Do not save when prompted.

Find a Higher Classification Unit 

5. In the View menu, highlight and click “Classification.”  The Classification window opens (Screen X-1). Note that it appears on top of the main application window, rather than replacing it. So does the USFS Ecoregion window. These subject area windows have a different structure than the others to display hierarchical data in a tree with expandable nodes as well as a tabular record.  Due to this structure, it is not possible to create working lists in these subject areas.

6. On the menu, select Tools – Find or click on the [image: image78.bmp] icon on the toolbar. The Find Classification window opens (Screen X-3).

7. Search for a classification unit by name: Enter dactyl as the text to search for (use “contains” as the Comparison).  Select Find Now or hit Enter to search. Do the same search for different Name Types and different Classification Levels and notice the different result sets (Screen X-4). Note that you cannot select a Classification Level if the “All” Name Type radio button is selected. This is because the classification hierarchy levels differ for taxa and communities.

8. Select an item in your results list and click OK. The tree view opens to that item and the tabular record is displayed on the right-hand portion of the screen (Screen X-2).

9. Close the Classification window by clicking the X at the upper right corner.

Add a New Classification Unit

10. Find Zoological Family Leptodactylidae and select it. With this family highlighted in the tree view, select File – New from the menu, or click the New icon [image: image79.bmp].

11. On the right-hand side of the window, type your first name in the Name text box, which initially contains the words “New Item” and a number.  (In other words, you are creating a new genus record in the family Leptodactylidae named, e.g., Ralph.) Add a description or comment.

12. Save the record by clicking the Save icon [image: image80.bmp] or using File – Save or Ctrl –S.

Add a New Element to the Database 

13. First, determine whether the scientific name for the new element is in your database:

a. Switch to the Scientific Name view. 

b. Open the Find Scientific Name window.

c. Search for your first and last name (e.g., jane doe), as though it is a scientific binomial. The search is not case sensitive.

14. Odds are, you won’t find your name! Before you can create a new EGT record, you have to create a new Scientific Name record. Select the New button on the Find window and choose Zoological as the Name Type (Screen II-1).

15. Enter your name in the Scientific Name field. It will automatically be in italics, but you can turn italics off in the Text Editor (hit F3 or the [image: image81.bmp] icon to open the Text Editor). 

16. Select values for Name Category and Classification Level.  In this case, the default values will be the correct ones. Default values are always filled in because these fields are non-nullable. The list of dropdown values differs depending on whether you previously selected Botanical, Zoological, or Ecological as the name type (Screen II-2).

17. Go to the References tab to fill in a reference for this name.  Click the [image: image82.bmp] button next to the grid to open the Find Reference window. For purposes of this example, find and select any reference (search by reference code or name), and click OK on the Find window to place it into the grid.

18. Designate this reference as “Primary” to clicking in the checkbox. You may also indicate that a reference is the original publication of the name (Screen II-3).

19. Save and close the Scientific Name record.

20. Return to the Element view.

21. Select File – New – Element Global Tracking.  If you click on the down arrow next to the icon, you get the same cascading menu as with File – New:  [image: image83.png]Bl Vew Lst Tooks telp
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If you click on the icon itself, the application “assumes” you are creating a global record. To create a new ENT or EST, you would have to have previously indicated which EGT (for the ENT) or ENT (for the EST) it was related to because the application enforces a geographic hierarchy among those records.

22.  In the Find Scientific Name window, search for the name you just created and click OK. A new EGT record opens (Screen IV-1).

d. Note that the name you selected is filled in on the Identifiers tab in two places: the Global Scientific Name and the Name Used in Concept Reference.

e. Note that the Reference you designated as “primary” in the Scientific Name record appears in two places: Primary Name Reference Citation and Concept Reference.

23. From the Classification Status dropdown, select the value “Nonstandard.”  You have now entered all the information required to save an EGT.  ELCODE is not required, but may be entered if you have that information.  Save the EGT.

24. Go to the Classification tab on the EGT. You can click on the tab or use the shortcut Alt-a (the underlined letter on the tab title).

25. Note that the Classification hierarchy fields are grayed out. You cannot type into them directly. The information is filled in by creating a link to the genus record in the classification tree. To create the link, click on the [image: image84.bmp] button next to the line labeled “Genus.”

26. In the Find Classification window, search for the genus you created earlier (your first name), and click OK. The Find window closes and the Global Classification fields in the EGT are filled in.

27. Go to the Std/Nonstd Rel tab. Since your element is a nonstandard, you will specify which standard element(s) (i.e., accepted by Central Botany, Zoology, or Ecology) it is related to (Screen XI-2).

28. Click the [image: image85.bmp] button. The Find Element window automatically limits your search to animal EGT records because: (1) you are starting from an animal record, and (2) standard-nonstandard relationships are assigned at the global level.

29. Search for an element with name beginning with rana. Select one of the several species that are returned and click OK. The standard element is filled into the grid. You can now add other information about the relationship. Save the EGT.

30. Double click on the row you just added to the grid.  The EGT for the standard element opens. Go to the Std-Nonstd Rel tab for that element and you will see that displays the inverse of the information you entered in the other record (Screen XI-3). 

In this exercise, you have just linked two frogs from different families as elements with similar circumscriptions—an unlikely situation.  You could just as easily have linked a frog with any other animal in the database, vertebrate or invertebrate!  Tracker enforces only minimal validation during data entry. 

31. Browse through the rest of the EGT tabs to see what data they contain.

ANNEX:  Biotics 4 Tracker screens for supplementary hands-on exercises

Screen I-1: The Element Group window.
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Screen II – 1. Scientific Name Find window
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Screen II-2. The Scientific Name record. 
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Screen II-3. Scientific Name reference tab, with primary reference filled in. [image: image89.png]Yscientific Name
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Screen III- 1. A species Element Global Tracking Record
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Screen III-2. A community Element Global Tracking record. Concept information is on the second tab, instead of the Identifiers tab. 
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Screen IV-1. A new EGT, showing required data fields.
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Screen VI-1. An inactivated Element Global Tracking record.
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Screen VII-1. Heritage Status tab, where ranking and distribution data are entered. This element is exotic in New York.
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Screen VII-2. Heritage status tab for a migratory element. This element is a resident breeder in NY, but is accidental as a nonbreeder.
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Screen X-1: Classification window
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Screen X-2: A node in the taxonomic hierarchy expanded to the lowest level (genus), with data entry form to right of tree view.

A similar data entry form exists for all levels, although some fields are specific to the family or genus level.
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Screen X-3: Searching for a classification unit record.
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Screen X-4: Search results
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Screen XI-1. A nonstandard plant EGT. The Taxonomy Comments tells why it is considered nonstandard.
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Screen XI-2. The relationship between the standard and nonstandard elements is entered in the EGT of the nonstandard element. 

Additional information about the relationship can also be entered.
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Screen XI-3. The relationship between the standard and nonstandard elements is displayed read-only in the EGT of the standard element.
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Notice that a check mark appears next to the selected subject area.  You can also turn on or off the toolbar and status bar (at the bottom of the window). The Welcome Window can also be turned back on from the View menu.





In each subject area, the user may create and edit one or more specific types of records and can search for records using a Find tool customized for that subject area.





The Geographic Level radio buttons on the Name tab specify the geographic level at which the name you are searching for is used


(e.g., you can search by GNAME, NNAME, or SNAME).





You can search by scientific or common name or both. You can also include related names (e.g., synonyms) in the search. Several different comparision options let you search by all or part of the name. The wildcard search character is %.





If Save Settings as Default is checked, the Find window will open with the same settings as the last time you used it. Use with caution, as it is easy to forget about the settings on hidden tabs and not get the results you expect!


View Search SQL allows you to preview the SQL generated by your search.





The results filter specifies whether your search will return EGTs, ENTs, and/or ESTs  (the default setting is all three levels). You can also include  or exclude “Inactive” (archived) Element Tracking records (default is to exclude them.)





The other options in this menu allow you to:


clear the working list window


open a previously saved list 


save changes to a previously saved list 


delete a list 


edit list attributes like name and description and shared status


selectively remove items (some or all)


generate another working list of records related to the ones on this list (e.g., all the EOs for these elements)


do a multi-column sort





Go to File – Open or the Open icon on the EO window toolbar.  The list shows all the types of related records to which you can navigate from the EO. There will always be related Element Tracking records (G, N, and S) and at least one Source Feature record. There may not be any of the other record types related with a given EO. If not, a message will display informing you that no related records of that type exist.


Click on Source Features.


In the tabular Source Feature record, enter a Location Use Class if the Element is a migratory animal. For non-migratory animals, enter Not applicable.


On the Observations tab, enter data about two different visits to the source feature area. To enter the second observation, highlight the empty line in the grid at the top of the tab.  Note that the data entered appears in the grid. 


On the QC tab, fill in the Data QC Status and Data QC By fields. (These fields exist in the EO record for QC of tabular EO data.)


Save the Source Feature record and close it.





By unchecking or checking the boxes on the Startup tab, you can indicate whether the Welcome Window and/or the working list you were viewing during your previous session should open automatically when you log into Tracker.





On this tab, you can specify whether and when you are prompted to save a working list. “Save when View change” and “Save on exit” will automatically update your saved lists with any changes you have made and will open the Save List As dialog for any unsaved lists. You may cancel at that point.





The menu items above the word “Toolbar” show the different subject areas of data managed in Biotics Tracker. A subject area may encompass more than one record type.  For example, the Element subject area is that access point to Element Tracking, Element Ranking, Element Characterization, EO Specs, EO Rank Specs, and several other types of records.


Note the new subject areas in Tracker: Element Group, Scientific Name, and Source Feature. The Source Abstract file has been renamed Reference to avoid confusion with Source Feature. 





By selecting the “New” button, you can begin creating a new Scientific Name record directly from the Find window if you don’t find what you are looking for. You can also create a new record from the main application window, Scientific Name view.





Unique identifiers





A default rank of GNR (“not ranked”) is automatically entered in a new record. 





The data in all fields except Classification Status defaulted from the Scientific Name record that was selected as the Global Name. If there was no primary reference designated in the name record, the Concept Reference would have to be filled in here before the  EGT could be saved. (For communities, the Concept Reference and Classification Status fields are on the second tab.)





Complete hierarchy for each result is displayed in the lower portion of the window when the row in the Search Results box is highlighted (single mouse click). 





Double-clicking on the row closes the Find window and opens the left(tree view) and right (data form) portions of the window to the selected classification unit. (Clicking OK does the same.) 





In the Standard EGT record, the application automatically interprets the type of relationship from the perspective of the standard (“Finer”), based on the value filled in by the user for the nonstandard in the previous record (“Broader”). 
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